Contents

What’s New in SAS Data Remediation 2.2 ........................................... vii

Chapter 1 • SAS Data Remediation ..................................................... 1
  About SAS Data Remediation ...................................................... 1

Chapter 2 • SAS Data Remediation Interface ...................................... 5
  Log On to SAS Data Management Console .................................. 5
  SAS Data Management Console Home Page .................................. 6
  Specifying Your Preferences ......................................................... 7
  Overview of the SAS Data Remediation Interface ......................... 11

Chapter 3 • Understanding SAS Data Remediation Administration ........ 13
  Working with SAS Data Remediation Administration .................. 13

Chapter 4 • Understanding SAS Data Remediation .......................... 27
  Working with SAS Data Remediation ........................................... 27

Chapter 5 • Example ................................................................. 39
  Tracking Issues ........................................................................... 39
  Workflow Integration ................................................................. 42

Recommended Reading ................................................................. 45
Index ............................................................................................... 47
Overview

The main enhancements and changes for SAS Data Remediation 2.2 include the following:

- group-by functionality
- remediation plug-in enhancements
- overview portlet
- saved preferences
- reports for SAS Visual Analytics
- documentation enhancements

Group-by Functionality

Static package, item, and issue view options have been replaced by a more flexible group-by feature. You can now group remediation issues by the following categories:

- Issue type
- Item
- Item ID
- Package
- Package ID
- Importance
- Due date
- Status
- Assignee
Hierarchical views of package, items, and issues can still be viewed through the Package and Item elements in the **Details** panel for each issue.

**Remediation Plug-in Enhancements**

SAS Data Remediation supports application plug-ins from other applications that contribute issues to SAS Data Remediation. SAS MDM is one of those applications and its remediation plug-in has been enhanced in this release. All issues that seem to refer to the same item are collected at the top of the plug-in. This lets business users gain an understanding of related issues that might have been logged against the same issue on multiple dates. Edit form interaction has been improved and item data can now be viewed without acting on the issue itself.

**Overview Portlet**

A new remediation portlet is available in SAS Data Management Console. This portlet displays summary information for issues in the SAS Data Remediation database grouped by the following categories:

- Type
- Assignee
- Importance
- Status
- Application
- Subject Area

**Saved Preferences**

User-based preferences are now preserved between SAS Data Remediation sessions. The set of columns selected for viewing and the details panel, if visible, in the main issue view are saved as well as the last filter setting. When you return to SAS Data Remediation after having exited it, the settings of these elements remain the same. SAS Data Remediation settings for Maximum issues to display and Age display maximum have been moved to the **Preferences** panel in the SAS Data Management Console.
Reports for SAS Visual Analytics

SAS Data Remediation provides a report and associated metadata that enables data stewards and business users to gain more insight on the type and frequency of remediation issues in the SAS Data Remediation database. You can see issue summaries by type and assignee, dates of issue creation and remediation, and other important metrics that provide an overview of the issues managed in the application.

Note: SAS Visual Analytics, available as a separate offering, is required to view this report.

Documentation Enhancements

The SAS Data Remediation content that was previously available in the SAS MDM: User’s Guide has been moved to this document.
What's New in SAS Data Remediation 2.2
About SAS Data Remediation

Overview

For many data-intensive IT projects, anomalies or inconsistencies in the data prevent systems involved from operating optimally and providing clean and timely data to each other and end users. Data remediation provides a means to identify, review, and correct the problem data before it reaches the downstream systems.

SAS Data Remediation makes it easy to capture and review problems found in enterprise data. SAS Data Remediation has a web-based interface for data administrators and a representational state transfer (REST) web service API for system integration. Both of these interfaces interact with a remediation database that contains information about where the problem data is located, which system generated the data, who should see the data, and how the data might be corrected.

Note: Only authenticated users can successfully access remediation functionality.

Configuration

Configuration of your SAS Data Remediation environment is handled by the standard SAS deployment process. If you are upgrading from a previous version of SAS Data Remediation, your remediation database is automatically updated when the SAS Data Remediation application is started on the server for the first time after installation of the newer version. All issues and their state remain current in the application.
How Issues Are Organized

Overview

IT systems or data-centric applications can interact with SAS Data Remediation through a REST web service API. This API enables the originating system, which contains data flagged by data quality business rules, to send information about the state and location of the data errors to SAS Data Remediation. SAS Data Remediation organizes the data and gives specific sets of users access to remediation issues, items, and packages. Issues, items, and packages are associated with an application and subject area in remediation. If a package is created for an application or subject area not already known to the data remediation service, then it is registered automatically with the service.

Issues

Issues are descriptions of the problems in the data and include information such as due dates, importance indicators, owners, and statuses. Issues can link to data elements that can be transmitted to remediation plug-ins. The plug-ins provide a way to correct the data flagged as having an issue, because source system data is not brought into SAS Data Remediation. Only a reference to the data is brought into SAS Data Remediation.

The following are properties of issues:

- Issues are linked to Issue Types that can have Tasks (workflow templates) associated with them. Tasks define a correction process. If an issue is associated with a workflow, it can be started by the data remediation service when the package is created. Issue details are automatically propagated into the workflow only at this time.
- When creating an issue, Assignee defaults to Unassigned if no assignee is designated.
- If an issue has a status of Open with no assignee, any authorized user can modify its writable fields: Importance, Status, Assignee, Due Date, and Note.
- If an issue has a status of In Workflow, any participant in the workflow can modify its writable fields: Importance and Note.
- If an issue has a status of Open with no assignee and you change the status to In Progress, you become the assignee.
- If an issue has a status of In Progress, only the assignee can modify its properties. The assignee can reassign the issue to another user, which resets the issue to a default status of Open. Because the status is Open, anyone can modify the issue.
- If an issue has a status of Closed or Rejected, its properties cannot be modified.

Items

Items are rows of data in a system. For example, a customer record is an item. SAS Data Remediation keeps tracks of the issues associated with an item. In SAS Data Remediation, items are the elements against which business rules have been run to look for erroneous data. Items do not capture the complete
external record, but generally point to the record through a key value. One or more issues can be associated with an item.

Packages

Packages are collections of items with issues. A single package is generated by a single business process so that all issues that come from the same process can be viewed collectively. One or more items can be associated with a package. After a package is created, you cannot add items or issues to it.

Note: Only packages can be deleted. Items or issues cannot be deleted.

SAS Management Console

SAS Data Remediation uses the SAS Management Console to define and configure various aspects of the processing environment. Users and roles are set within SAS Management Console. For more information, see SAS Management Console: Guide to Users and Permissions.

Erroneous data or non-compliant processes can be sent to SAS Data Remediation in several ways. These methods include, but are not limited to, the following programs:

SAS MDM
Applications send problem records to SAS Data Remediation for review and correction via the REST API. When issues that need attention enter SAS Data Remediation, the issues appear in a list in the SAS Data Remediation interface.

SAS Data Integration Studio
Users can write data integration processes that can use the REST API to send problem records to SAS Data Remediation for review and correction.
Log On to SAS Data Management Console

You can access SAS Data Remediation through the standard logon window for SAS applications. This window opens SAS Data Management Console from which you can launch SAS Task Manager.

The port for all SAS Data Management web components is configured during installation. The default port number is 80. If your site is using the default port for these web components, you can access SAS Data Management Console from the following URL: http://hostname/SASDataManagement.

If your site is not using the default port for these web components, you must specify the port in the URL. For example, if the port is 7980, you can access SAS Data Management Console from the following URL: http://hostname:7980/SASDataManagement.

To log on to SAS Data Management Console:

1. Click the URL that is supplied by your system administrator, or paste it into the address field of your browser to display the SAS logon window:
2 In the **User ID** field, enter your user ID.

3 In the **Password** field, enter the password for your user ID.
   
   **Note:** Your password is case-sensitive. Your user ID might be case-sensitive, depending on the operating system that is used to host the web application server. If you need assistance, contact your system administrator.

4 Click **Log On** to display SAS Data Management Console.

   **Note:** If you log on to SAS Data Remediation in one browser tab, and then log on to SAS Data Remediation or a different SAS web application in another browser tab, the same credentials are used automatically for subsequent authentication attempts.

   To log off from SAS Data Management Console, click **Sign Out** in the upper right corner of the user interface:

**Figure 2.2  SAS Data Management Console**

Note: When you select **Sign Out**, you are logged off from all tabs opened by the SAS Management Console.

---

**SAS Data Management Console Home Page**

The SAS Data Management Console home page enables you to launch SAS Data Remediation.

**Note:** The following image is an example. Your specific content might be different.
The File menu on the menu bar enables you to set preferences.

The Help menu enables you to access user’s guides and SAS on the web.

The DATA REMEDIATION portlet lists, and enables you to open, current task manager items.

The DATA REMEDIATION SUMMARY portlet provides summary statistics on issues tracked in the SAS Data Remediation databases.

The APPS listings link you to the component applications.

Note: The list of applications available to you varies according to your assigned role and to which SAS products you have installed.

Specifying Your Preferences

Specifying Global Preferences

You can specify global preferences to apply to all SAS web applications that are displayed with the Adobe Flash player. These preferences are set by each user.

To specify global preferences:

1. Select File ▶ Preferences to open the Preferences window.
2 Click **Global Preferences** in the left pane.

3 Select the **User locale** drop-down menu to specify your language and geographic region.

   Select the **Theme** drop-down menu to change the color scheme and other visual settings for all of your SAS web applications.

   Select the **Invert application colors** check box to invert all of the colors in your SAS web applications.

   Select the **Override settings for focus indicator** check box to change the color, thickness, and opacity of the focus in your SAS web applications.

4 Click **OK** to apply your changes.

5 Click **Reset to Defaults** to restore default settings.

**Note:** If you changed the **User locale**, then you must log off and log back on to SAS Data Remediation for the change to take effect.

### Specifying SAS Data Remediation Preferences

To specify SAS Data Remediation preferences:

1 Select **File ▶ Preferences** to open the Preferences window.

2 Click **Remediation** in the left pane.
3 Select a value in the **Age display maximum** field to set the maximum number of days displayed in the Age column of the issues list on the **Data Remediation** tab. The default is 30 days. For more information, see "Data Remediation Portlet" on page 29.

4 Select a value in the **Maximum number of issues to display** field to set the number of issues returned to the application from the data remediation database when queries are made to create Package, Item (issues per item) and Issue views. The default is 500.

5 Select the **Retrieve newest issues first** check box to set whether newest or oldest issues are to be retrieved first from the server before any other queue filter or sort order is applied. This applies when the number of issues on the server exceeds the value set for the **Maximum number of issues to display** field.

6 Select the **Hide closed and rejected issues** check box to hide from view any issues with a status of closed or rejected.

7 Click **OK** to apply your changes.

8 Click **Reset to Defaults** to restore default settings.
Specifying SAS Data Management Console Preferences

To specify SAS Data Management Console preferences:

1. Select File ➤ Preferences to open the Preferences window.
2. Click Data Management Console in the left pane.

Figure 2.6 SAS Data Management Console Preferences

3. Specify the location of portlet panes that appear on SAS Data Management Console.
4. Click OK to apply your changes.
5. Click Reset to Defaults to restore default settings.
Overview of the SAS Data Remediation Interface

Menu Options

The SAS Data Remediation interface has several common features. The toolbars of the interface contain an **Actions** menu. Clicking displays the **Actions** menu and enables you to select specific options. Most options available from the **Actions** menu are also available through icons on the same toolbar. Holding the cursor over the icon displays the function of the icon. Clicking the icon performs the function.

You can click icons to expand and collapse elements of the interface. Click or to expand an item. Click or to collapse an item.

Tables

SAS Data Remediation presents lists of issues in a tabular form. These tables show a subset of the information associated with the issues. All entries in a table are the same type of issue. To open an issue in an editor, double-click or right-click the row, and select **Open** or **Edit** from the pop-up menu.

*Figure 2.7 Sample Table*

<table>
<thead>
<tr>
<th>Issue</th>
<th>Package</th>
<th>Item</th>
<th>Subject Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>INVALID OR MISSING DATA</td>
<td>add_update_individual</td>
<td>WILLIAM L PHILLIPS</td>
<td>INDIVIDUAL</td>
</tr>
<tr>
<td>INVALID OR MISSING DATA</td>
<td>add_update_individual</td>
<td>WILLIAM L PHILLIPS</td>
<td>INDIVIDUAL</td>
</tr>
<tr>
<td>INVALID OR MISSING DATA</td>
<td>add_update_individual</td>
<td>AUDREA BECKETT</td>
<td>INDIVIDUAL</td>
</tr>
</tbody>
</table>

To open an issue, you can do any of the following:

- Click from the toolbar.
- Click and select **Open** or **Edit**.
- Double-click a table row.
- Right-click a table row and select **Open** or **Edit** from the pop-up menu.

To sort a table column in either ascending or descending order, click the column heading. Sorted columns display up or down arrows to indicate the sort direction.
Fields

Required fields on the interface are marked with an asterisk (*). Read-only fields appear dimmed.

Figure 2.8  Fields

If you enter invalid information in a field, a red border appears around the field. You can hold the mouse over the red border to view information about the invalid field entry.

For date fields, you can either enter the date directly or click \(\text{ }\) to display a calendar. From the calendar, click a valid date to load it into the field. Click the navigation buttons to change the month and year. Click anywhere outside the calendar to hide it.
Working with SAS Data Remediation Administration

Overview

The SAS Data Remediation Administration tab provides a work area where the administrator configures settings, sets access controls, and plans permissions within SAS Data Remediation views. The administrator sets up each application that interacts with SAS Data Remediation and includes the name of the application, subject areas, and issue types.

Note: SAS Data Remediation Administration tab is available only to users with administrator privileges, that is, either the Data Remediation:Issue Administration role or the Data Remediation View Application and Issue Administration capabilities.

SAS Data Remediation Administration Tab

Overview

To open the SAS Data Remediation Administration tab, click the Administration option under Data Remediation from the SAS Data Management Console. From here, you can add new client applications for data remediation or view and edit existing applications.
The toolbar at the top of the tab contains an **Actions** menu with the following options:

**Add Client Application**
adds a new client application used to interact with SAS Data Remediation.

**Open**
opens the remediation record for client application.

**Delete**
removes the client application selected in the client application list.

**Refresh**
refreshes the list of client applications.

**About SAS Data Remediation**
displays application version information.

**Adding and Editing Client Applications**

When the **SAS Data Remediation Administration** tab first opens, no applications are associated with the software. You can configure any client applications that you want to use within SAS Data Remediation. Alternatively, the first time an application uses the data remediation service, an association is made for the application if it does not already exist.

1. To add an application to SAS Data Remediation, click **Add Client Application**.

2. (Optional) To edit an existing application, select the application in the application list.

After you add or open an application, a new tab opens with three sub-tabs: **Properties**, **Subject Areas**, and **Issue Types**.
The toolbar at the top of the tab contains an **Actions** menu with the following options:

**Save**
- saves changes to the application information.

**Refresh**
- refreshes information about the tab.

The **Properties** tab is displayed by default. The following sections describe the use of these tabs for adding or editing applications.

### Properties Tab

The **Properties** tab displays the following fields:

**ID** [required]
- a unique identifier. Once this field is saved, you cannot make changes to the ID.

**Display Name** [required]
- the name that is displayed for the client application.

**Description**
- the description of the application.

**Created**
- the date on which the application was added to remediation.
Created by
the user name of the person who created the link to the application for remediation.

Modified
the date on which the application was last changed.

Modified by
the user name of the person who last changed the application information.

URL to notify of issue status
the URL invoked when issue status changes have been made. This does not apply to issues that are in a transitional status in the workflow. To achieve similar behavior from a workflow instance, the same user-supplied URL would have to be called from a workflow web service policy when the workflow status changes.

Allow dynamic creation of subject areas and issue types
enables applications to create subject areas and issue types through REST API web service calls. When this is disabled, subject areas and issues types must be defined first in this application before new issues can be created from external applications that refer to them.

No user interface configured
enables users to manage issues without a specific application selected. With this setting, no corrective action can take place on the data that originally contained the issue. Only issue tracking properties such as Importance or Assignee are enabled.

Application provides custom plug-in user interface (.swf)
specifies that an external application provides a web-based user interface when a value is set for the .swf file. You can fix issues in this interface.

One .swf for all issue types
selecting this option enables you to specify the location of one .swf file for all Issue Types that are defined for this application. The plug-in .swf issue code field, on the Issue Types tab, enables you to specify a form to present to the user if the same .swf file contains several form types.

Note: For SAS MDM, set the One .swf for all issue types field to /SASMDM/modules/sas.dm.mdm.remediation.flex/sas.dm.mdm.remediation.flex.swf. Leave the plug-in .swf issue code field, on the Issue Types tab, blank.

One .swf for each issue type
selecting this option enables you to specify the location of one .swf file for each Issue Type that is defined for this application. The plug-in .swf field, on the Issue Types tab, enables you to specify the full path for the .swf file associated with the issue.

Use default remediation UI and retrieve or send remediation item attributes and actions using HTTP
selecting this option enables you to specify a server that supports external REST web services. This option provides a simple edit form from which you can correct issues if an external set of REST web services is available to read and write data. When you choose to access an issue configured to use this option, the REST call is used to GET the external data, which is presented for editing. When you invoke the Save operation, the PUT web service is called to send the data back to the external application.
URL to retrieve item attributes (GET)
the URL invoked when SAS Data Remediation opens an issue to retrieve data from an external process. Design the custom REST web service so that the HTTP call that uses the GET function retrieves one data row.

URL to send item attributes (PUT)
the URL invoked when SAS Data Remediation accepts the correction and sends the data back to an external process. Design the custom REST web service so that the HTTP call that uses the PUT function takes data elements from one row in data remediation and sends it to the external process.

Click on the toolbar to refresh the Properties tab view.

Subject Areas Tab

Overview
The Subject Areas tab displays a list of subject areas that have been defined on this tab or defined through a web service call made by another application. A subject area is a way to categorize remediation issues. You can specify that only certain users are given access to a subject area. From this tab, you can also add subject areas to and delete them from the application. The Subject Areas tab is divided into three sections: a list of subject areas in the left pane, a Properties tab, and a Task Templates tab. The Properties tab is displayed by default.

Figure 3.4 Subject Areas Tab

The toolbar at the top of the tab contains an Actions menu with the following options:
New Subject Area
creates a new subject area in the subject areas list.

Delete
deletes a selected subject area from the subject areas list. Removing an application or subject area removes the associated packages and their contents.

Properties Tab
The Properties tab displays the following fields for the subject area selected in the subject areas list:

Name [required]
the subject area name. Once you save this name, you cannot change the field.

Description
the description of the subject area.

Created
date on which the subject area was created.

Created by
the user name of the person who created the subject area.

Modified
date on which the subject area was last changed.

Modified by
the user name of the person who last changed the subject area.

Permissions Tab
On the Permissions tab, you can set permissions for SAS Data Remediation users. You can also add and remove users. The list of available users here is the set of users added through SAS Management Console who have been assigned roles that use capabilities defined for SAS Data Remediation. Users defined in SAS Management Console who are not assigned a role using SAS Data Remediation capabilities do not appear in the list of users. Setting permissions grants or revokes access for a set of users for a given Subject Area. For information about SAS Management Console, see SAS Management Console: Guide to Users and Permissions.
The toolbar at the top of the tab contains an **Actions** menu with the following options:

**Select Users**
- opens a dialog box that enables you to select users who have permissions on the selected subject area.

**Delete**
- deletes the selected user from the list of users who have permissions on the selected subject area. You can select multiple users for deletion.

To select users:

1. Click ![Select Users...](image). The following dialog box appears:

   ![Select Users](image)

2. Enter characters into the search field. The list of users is filtered by the search criteria as you enter characters. Click ![Clear](image) to clear the search field and restore the full list of users.

3. Select or deselect users as follows:
   - To select individual user names, select the check box next to the applicable name or names.
To select all users, click **Select All**.

To deselect all users, click **Deselect All**.

4 Click **OK**.

If no permissions are set, all users of SAS Data Remediation can see all data issues for a given Subject Area. If you choose to add users for a particular subject area, you are disallowing access for all non-selected users.

You can choose to assign Read-Only access to some users. To enable this, select the check box next to the user name once it has been added to the permissions table.

**Figure 3.7** Subject Areas Permissions Tab

### Issue Types Tab

**Overview**

The **Issue Types** tab displays a list of issue types identified by the application that you are currently viewing. Issue types are a way to categorize issues, making it easy to sort and filter a set of issues before working with them. Issue types can be associated with Task Templates. These templates are user-defined workflows that can be used to route issues to the right user or through the right process. From this tab, you can add new issue types to the application, edit existing issue types, or delete issue types. The **Issue Types** tab is divided into three sections: a list of issue types in the left pane, a **Properties** tab, and a **Task Templates** tab. The **Properties** tab is displayed by default.
The toolbar at the top of the tab contains an **Actions** menu with the following options:

- **New Issue Type**
  creates a new issue type in the issue types list.

- **Delete**
  deletes a selected issue type from the issue types list. Issue types cannot be deleted unless all issues that refer to that issue type have been deleted from the system by using Delete Package functionality. The Delete action is enabled only for issue types that meet this criterion.

### Properties Tab

The **Properties** tab displays the following fields for the issue type selected in the issue types list:

- **Name** [required]
  the issue type name. Once you save this name, you cannot change the field.

- **Description**
  the description of issue type

- **plug-in .swf issue code**
  this option is displayed only if, on the main **Properties** tab, you have selected both **Application provides custom plug-in user interface (.swf)** and **One .swf for all issue types**. The **plug-in .swf issue code** field enables you to specify a form to present to the user if the same .swf file supports several form types.

  **Note:** For SAS MDM, leave the **plug-in .swf issue code** field blank.
plug-in .swf
this option is displayed only if, on the main Properties tab, you have selected both Application provides custom plug-in user interface (.swf) and One .swf for each issue type. The plug-in .swf field enables you to specify the full path for the .swf file associated with the issue.

Created
date on which the issue type was created.

Created by
the user name of the person who created the issue type.

Modified
date on which the issue type was last changed.

Modified by
the user name of the person who last changed the issue type.

Task Templates Tab
On the Task Templates tab, you can view the workflow templates that have been uploaded through SAS Workflow Studio to the SAS Workflow server and activated. You can associate one or more task templates (workflow definitions) with the selected issue type. For more information about SAS Workflow Studio, see SAS Management Console: Guide to Users and Permissions.

The toolbar at the top of the tab contains an Actions menu with the following options:

Select Templates
opens a dialog box that enables you to select task templates (workflow templates) to associate with the issue type selected in the issue types list.
Delete deletes the selected task templates associated with the issue. You can select multiple task templates for deletion.

To select templates, click `Select Templates...`. The following dialog box appears:

### Figure 3.10 Select Templates

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MDM Tag Close Issue</td>
<td>This workflow template is designed to be called f...</td>
</tr>
<tr>
<td>MDM Lifecycle</td>
<td>This workflow template is designed to be called f...</td>
</tr>
<tr>
<td>MDM Tag</td>
<td>This workflow template is designed to be called f...</td>
</tr>
</tbody>
</table>

1 items selected

You can click the box next to tasks to select them, click `Select All` to select all tasks, or click `Deselect All` to deselect all tasks.

You can require a user to address a remediation issue through a defined workflow. To enable this, select the **Always require a task template to be used to resolve issues of this type** check box. If this option is selected, when an external system creates a new remediation issue, it must provide the name of one of the approved workflow templates for the selected issue type. If a workflow template is not provided or is incorrectly specified, the issue is not created. Once the workflow has started, the workflow design provides additional menu actions.

If this setting is applied to an issue type after issues of that issue type have already been created in the system, those existing issues are not affected by the change. If this setting is disabled after issues have already been created and workflows have been started for them, the existing issues continue to use workflows while the new issue does not require them.
SAS Data Remediation Roles

SAS Data Remediation creates three new roles in SAS Management Console. These roles are tied to distinct capabilities in the data remediation application. Depending on assigned role of the user, the experience in SAS Data Remediation changes. Certain features are available to those assigned one role, but the same features are not available to users in another role.

Here are the roles for SAS Data Remediation:

Table 3.1 SAS Data Remediation Roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Default Groups</th>
<th>Capability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Remediation: Issue</td>
<td>Data Management Administrators</td>
<td>- View Application: The user can view packages, items, and issues.</td>
</tr>
<tr>
<td>Administration</td>
<td></td>
<td>- Manage Tasks: The user can edit packages, items, and issues.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Issue Administration: The user can configure SAS Data Remediation applications, subject areas, and issue types.</td>
</tr>
<tr>
<td>Data Remediation: Issue</td>
<td>Data Management Stewards</td>
<td>- View Application: The user can view packages, items, and issues.</td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td>- Manage Issues: The user can edit packages, items, and issues.</td>
</tr>
<tr>
<td>Data Remediation: Issue</td>
<td>Data Management Business Users</td>
<td>- View Application: The user can view packages, items, and issues.</td>
</tr>
<tr>
<td>View</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Configuring Reports for SAS Visual Analytics
(Optional)

SAS MDM provides a remediation report that runs on SAS Visual Analytics using data obtained from SAS Data Remediation. The remediation report link must be properly configured for the report to work correctly. The person performing these configuration steps must be a SAS administrator.

To update the remediation report link:

1. Log on to the SAS Management Console with administrator permissions.
2. Click the Folders tab, and then navigate to SAS Folders ➤ Products ➤ SAS Data Remediation.
3. Edit the URL Link stored process and replace the reference to localhost with the fully qualified host name corresponding to the SAS Data Remediation application.
4. Log on to the SAS Visual Analytics Hub. You must have SAS Administrators permission.
5. From the main menu, select Design Report.
7. In the Open dialog box, select SAS Folders ➤ Products ➤ SAS MDM ➤ Reports ➤ RemediationReport, and then click Open.
8. Click the Issue Details tab and edit Link to external URL: URL Link to replace the reference to localhost with the fully qualified host name corresponding to the SAS Data Remediation application.
9. Save the report.

Logs

Logs for SAS Data Remediation can be found on the application server that hosts it. They are typically found in a location similar to the following:

SAS Data Remediation

..\Config\Lev1\Web\Logs\SASServer13_1\SASDataRemediation.log

Other logs that might be useful for troubleshooting might not be on the same system as SAS Data Remediation. Examples are as follows:

SAS Workflow

..\Config\Lev1\Web\Logs\SASServer1_1\SASWorkflowServices\x.x.jpg

SAS Metadata Server

..\Config\Lev1\SASMeta\MetadataServer\Logs
Understanding SAS Data Remediation

Working with SAS Data Remediation

Overview

The Data Remediation tab enables you to take action necessary to resolve data issues. An issue is a problem caused by a conflict with user-defined business rules that has been found in data or a process. An item is a record that is associated with an issue. A package is a collection of items and issues. The package can originate from any system your enterprise uses to store and process data.

Your system administrator defines applications in SAS Data Remediation that send data remediation issues to the data remediation environment. Applications can be used to correct data issues. Subject areas categorize the data in such a way that groups of users are given access only to the necessary domain. For example, in SAS MDM, the subject areas are the different entity types that are defined in SAS MDM.

Working with Issues

SAS Data Remediation is designed to manage a practical number of issues assigned to it by an application. A practical number of issues means that they can be reasonably managed by the data stewards assigned to the task. For example, it would be unreasonable for SAS Data Remediation to track 50,000 issues a week because, without a large number of data stewards, it would not be possible to review and correct all of these issues. Although the SAS Data Remediation database might be able to handle very large numbers of issues, those issues that can be displayed at a given time in the web application and allow it to remain responsive to user control is much smaller.
SAS Data Remediation has a setting that enables you to control the maximum number of issues that are retrieved at any given time in the SAS Data Remediation application views. For more information about this setting, see “Specifying SAS Data Remediation Preferences” on page 8.

If you set the maximum number of issues to be viewed to a value that is less than the total number of issues in an item or package, you need to use a combination of sorting and filtering in the appropriate view to see all data in the remediation database that might be relevant. For example, a default view for items might show only the first 500 items. You can use a filter to limit that list to only the items with issues that you own and that have been open for longer than one week. After refreshing the view, you see updated data with your filter applied. The maximum number limit is applied after the filter is applied. Users can work through the entire set of remediation issues, while ensuring that the web application continues to work optimally, by applying selective filters to data and refreshing the view periodically to retrieve the latest issues.

**Portlets**

**Overview**

On the SAS Data Management Console, the **Data Remediation** portlet displays an overview of issues and a sampling of data and enables you to open individual issues. The **Data Remediation Summary** portlet summarizes data, but does not allow you to take action on any of the individual items.

*Figure 4.1  SAS Data Management Console*

Note: In the following descriptions, **Actions** menu items are accessed by clicking 🗂. Some functions available from the **Actions** menu are also available from icons next to the **Actions** menu. Clicking the icon performs the function.

You can click **Data Remediation** or **Data Remediation Summary** in the portlets, or **Data Remediation** under APPS to open SAS Data Remediation on a new tab, which displays the table of issues:
Figure 4.2  SAS Data Remediation Tab

Data Remediation Summary Portlet

The top right area of the portlet contains an Actions menu with the following options:

Only show my issues
displays only the issues assigned to you.

Show all issues
displays all issues.

Refresh
refreshes the list of items in the portlet list.

Note: The portlet does not refresh automatically. You must refresh it.

Close the Portlet
closes the portlet on the SAS Data Management Console.

Data Remediation Portlet

The top right area of the portlet contains an Actions menu with the following options:

Display
enables you to check the number of items to display in the portlet. You can choose from 5, 10, 20, or 40 items.

Refresh
refreshes the list of items in the portlet list.

Note: The portlet does not refresh automatically. You must refresh it.

Close the Portlet
closes the portlet on the SAS Data Management Console.

When you click an item in the portlet list, the item opens on a new tab.
SAS Data Remediation Tab

Quick Search

The SAS Data Remediation tab displays a complete list of issues. You can perform either a quick search or an advanced search to narrow this list to the issues that you want to view.

To perform a quick search:

1. Enter the search term into the search field in the toolbar
2. Do one of the following:
   - Click to begin the search.
   - Click to clear the search data.

Note: To view the complete issues list again, click to clear the search characters, and then click to restore the list.

Advanced Search

To perform an advanced search:

1. Click to display search criteria:

   Figure 4.3 Advanced Search Options

2. You can do any of the following:
   - Click to expand all the search categories.
   - Click to collapse all the search categories.
   - Click to restore the search criteria to their default settings.
Click \( \text{again to close search options.} \)

3 After specifying the search criteria, click \( \text{to initiate the search.} \)

Note:

- To view the complete issues list again, click \( \text{to restore the search criteria to their default settings, and then click} \) to restore the list.

Managing Issues

The toolbar contains a drop-down list that enables you to group the entries in the table in a number of ways. For example, you might choose to group the entries by Issue Type, Item, or Package, among others. The default is ungrouped, which displays the complete list of issues.

Note: To group issues by exactly the same item or package, use the group by options for Item ID and Package ID. If you choose to group by Item or Package, issues might appear in the grouping that share the same label for the item or package, but might actually refer to different underlying data.

The toolbar also contains an Actions menu with the following options:

Open
opens the issue selected in the issues table on a new tab. Selecting multiple issues opens multiple new tabs. The actions available on the new tab are dependent on the application in which the issue is found.

Delete
deletes the selected package when the table is grouped by Package ID. Deleting a package is the only way to delete items and their associated issues.

Details Pane
displays or hides details of selected rows in the issues table in a separate pane beneath the table. Changes made in the Details pane are saved immediately. The Details pane does not have a save button.

Select Columns
enables you to select which columns appear in the table view.

Refresh
refreshes information about the tab.

About SAS Data Remediation
displays application version information.

If you have chosen to group items such that folders are displayed in the table entries, the following additional options are enabled:

Expand Selected
expands the folder selected in the table.

Expand All
expands all the folders in the table.

Collapse Selected
collapses the folder selected in the table.

Collapse All
collapses all the folders in the table.
The Details pane, if open, displays details about the selected item:

**Figure 4.4  Details Pane**

The Details pane includes a toolbar at the bottom of the pane. When an individual issue is opened on a new tab, the toolbar is displayed at the top of the pane.

The toolbar contains the following options:

- **Claim**
  - assigns the issue to you as Assignee and sets the issue to a status of In-Progress. After you have claimed the issue, this icon changes to **Release**, which enables you to release the issue.

- **Release**
  - sets the issue to a status of Open, so others can claim the issue, but leaves the current Assignee as is.

- **Close**
  - closes the issue when it is resolved. An issue with a closed status cannot be changed. Information about the closed status can be entered in the **Note** field.

- **Reject**
  - rejects the issue when it is invalid. Information about the invalid issue can be entered in the **Note** field.

- **Put in Workflow**
  - creates a new workflow instance for the selected issue. Available only if you have associated one or more task templates with the issue type of the selected issue.

  **Note:** **Put in Workflow** opens a dialog box where you can associate a SAS Workflow Studio workflow template with the issue.

If a task has already been created for the issue, the options available in the toolbar depend on the SAS Workflow Studio workflow template associated with the issue.

The Details pane includes two, and possibly three, tabs:
On the **Issue Details** tab, you can view or edit specific information about the issue. Changes made on the **Issue Details** tab are saved immediately. The Details pane does not have a save button.

The **Issue Details** tab displays the following fields:

**Status**
the current state of the issue, such as Open, In Progress, Closed, or Rejected. If a task was created for the issue, then the workflow supplies the status, depending on the current step in the workflow.

- **Open** is the initial status of a data remediation issue. This status can also be selected if the assigned owner wants to reassign the issue to a new owner.

- **In Progress** indicates that ownership has been accepted and the issue is being actively addressed. Users other than the assigned owner cannot work on the issue.

  **Note:** When you select a status of **In Progress**, you automatically become the **Assignee** for the issue.

- **In Workflow** indicates that a data remediation issue is being actively addressed in the workflow. Users other than the participants in the workflow cannot work on the issue.

  **Note:** After the workflow is completed, the **Assignee** is automatically set to the initiator of the workflow and the status is changed to **Open**. If the initiator is the current user, the status of the issue is set to **In Progress**.

- **Closed** indicates that a data remediation issue is resolved. An issue cannot be changed from a **Closed** status. Enter resolution information in the **Note** field before closing the issue.

- **Rejected** indicates an invalid data remediation issue that requires no additional action. Enter rejection information in the **Note** field before closing the issue.

**Importance**
the priority of the issue represented by star icons. The scale ranges from very low (1 star) through low, medium, and high, up to critical (5 stars).

**Assignee**
is the user name of the person assigned to the issue. Click **Assignee** to select from an available list of assignees. The list of users is derived from those who have been assigned at least one data remediation role in SAS Management Console.

**Note:** When you select a status of **In Progress**, you automatically become the **Assignee** for the issue.
Due Date

is the date by which an issue should be resolved. Click to select a date from the calendar. This option is not connected to alerts. To set up alerts, you must create a task for the issue that includes defined notifications.

Note

is a field used to record notes about the issue. Click to enter your comments in the Note field.

Issue

is the label for the type of issue found in the data.

Item

is the record that triggered the remediation process. Clicking the link next to the Item name opens a dialog box displaying details of the item in an item hierarchy table:

![Figure 4.6 Item Details](image)

Package

is the package in which the issue is located. Clicking the link next to the Package name opens a dialog box displaying details of the package. The area above the package hierarchy table displays any package level notes and is editable.

![Figure 4.7 Package Details](image)

Subject Area

is the subject area assigned to the issue.

Application

is the application where the issue is found.

On the Issue Data tab, you can view data about the issue. The Issue Data tab displays the following fields:
Figure 4.8  Issue Data

Link displays an Open in Application hyperlink that opens a new browser tab in the specified URL location if a properly formatted URL was submitted with the remediation issue.

Field 1 is a user-defined field. It contains a data value from the external application that originally flagged the item as an issue. The label for this field can be changed programmatically.

Field 2 is a user-defined field. It contains a data value from the external application that originally flagged the item as an issue. The label for this field can be changed programmatically.

Field 3 is a user-defined field. It contains a data value from the external application that originally flagged the item as an issue. The label for this field can be changed programmatically.

For example, the three user-defined fields might appear as follows:

Figure 4.9  Issue Data

If a task has already been created for the issue, the Details pane includes a third tab, Task Data:

Figure 4.10  Task Data

Process Invoker:  bndjbr  Process Title:  ABBEY EARLS - INVALID OR MISSING DA...
The following data object values are always provided by the workflow engine in Task Data:

**Process Invoker**
the user who sent the task to SAS Task Manager.

**Process Title**
the name used in SAS Data Remediation for the selected task.

The display of other values on the Task Data are controlled by the design of your workflow template. These values are data objects defined in the workflow template itself. For details, see the SAS Task Manager: User’s Guide.

### Deep Linking to Issues in Data Remediation

Deep linking refers to constructing a URL hyperlink that, once initiated, can take a user directly to an issue in SAS Data Remediation rather than requiring the user to search for it. For example, you can construct a URL link in an e-mail and send to a data steward. When the data steward clicks the URL link, it opens the SAS Data Remediation application and loads the issue encoded in the URL.

From within the appropriate environment, create a URL using the following syntax:

http://<your_host>/SASDataManagement/
#issue=<issue_ID>&module=REMEDIATION

For example, you might create the following:

http://localhost:8080/SASDataManagement/
#issue=4312&module=REMEDIATION

Note: Creating a remediation issue in SAS MDM submits a deep link along with the issue, which is accessible through the SAS Data Remediation web service API. For more information, see the SAS MDM: User’s Guide.

### Reports for SAS Visual Analytics

**Overview**

A single report with sub-reports is available for use with SAS Visual Analytics. You must execute a scheduled load process in the SAS Visual Analytics environment to generate the data needed for the SAS Data Remediation charts and tables in the report. Data for the report can be pushed from the SAS Data Remediation database to SAS Visual Analytics using a SAS MDM tool or other means documented in SAS Visual Analytics: User’s Guide. For details about pushing data to reports, see SAS MDM: User’s Guide.

**Note:**

- If you attempt to load more data or allow more users than SAS guidelines specify, you are likely to see performance degradation. See SAS documentation regarding SAS Visual Analytics server sizing and in-memory table size limitations.
- If you plan to make customizations to this report to meet the requirements of your project, make a copy of this initial report and add your customizations to the new version. Doing so protects customizations from being lost if report template enhancements become available in future releases.
Components

Several components are required to make the report properly viewable to users:

RemediationReport
The RemediationReport is the SAS Visual Analytics report file. It is installed for you in your SAS metadata environment in this location: ..\Products \SAS Data Remediation\Reports.

data table view
The RemediationReport requires a data table view from the SAS Data Remediation database to be available to load into memory of the SAS Visual Analytics environment. The metadata for this view can be found at this location: ..\Products\SAS Data Remediation\Data Sources\Data Remediation LASR\sas_rem_issues_vw

stored procedure
A SAS stored procedure is required to enable drill-down functionality from within the report. The stored procedure must be set up to run on the appropriate SAS Stored Process Server. The stored procedure can be found at this location: ..\Products\SAS Data Remediation\URL Link

Verify that the base server URL defined in this stored process is correct. In the following code, the http address must be set to the SAS mid-tier server used to host SAS Data Remediation:

%let server_string = http://sasmdm.demo.sas.com;

The RemediationReport sub-report named issue details contains an interaction that invokes the stored procedure described above. Edit the host and port of the stored procedure defined in the interaction to point to the SAS mid-tier server used to host the SAS Stored Process server. For more information, see “Configuring Reports for SAS Visual Analytics (Optional)” on page 25.

With these pieces in place, you can use standard SAS scheduling capabilities to load new data remediation data routinely into the SAS Visual Analytics environment.

Sub-Reports
The RemediationReport contains the following sub-reports on different tabs:

issue summary
  displays the number of records added to remediation (by assignee, by type, by subject area, by application, by status, by importance). Data can be filtered using range-slider and drop-down controls at the top of the report. Progressing through the charts takes you to a filtered Issue Details tab.

issue details
  displays issue in remediation in tabular form. Double-clicking an issue opens the selected issue in the SAS Data Remediation application. This action is enabled by the URL Link stored procedure.

issue activity
  displays issue status by date and issue activity by type. Data can be filtered by subject area and importance using the drop-down lists. The date section in the top panel can be used to progress to smaller date increments.

package metrics
  displays issues by package. Work flow details are displayed if available. Data can be filtered by date range slider or package type.
response time snapshot
displays issue response metrics by assignee and by issue type.

Database Connections to the Data Remediation Database

The SAS Visual Analytics reports for SAS Data Remediation rely on a database connection to the Data Remediation mid-tier Postgres data store. A connection to this database is made using SAS/ACCESS to Postgres.
Example

Tracking Issues

Overview

SAS Data Remediation is designed as a general purpose issue tracking system that can be used with both SAS and other applications. A common use case is to capture business rules violations from a data loading process for review by a non-technical user. The following is one example of how this might be accomplished.

Define an Application

To define an application:

1. On the SAS Data Management Console, select Data Remediation ➤ Administration.

2. On the Data Remediation-Administration tab, select Add Client Application from the Actions menu. A New Client Application tab is displayed with three sub-tabs.

3. On the Properties sub-tab:
   a. Give the application a unique ID and Display name, such as POS System.
   b. Select No user interface configured.

4. On the Subject Areas ➤ Properties sub-tab, enter the name Sales Transaction in the Name field. Do not apply any special access permissions to this subject area on the Subject Areas ➤ Permissions.
On the **Issues ➤ Properties** sub-tab, enter the name Missing Transaction Total in the **Name** field. If you want to associate a Task template with this issue type, select your custom task template on the **Task Templates** sub-tab. For more information, see “Workflow Integration” on page 42.

Save your settings from the **Actions** menu.

You are now ready to create new issues for this application in another tool such as SAS Data Integration Studio, SAS Data Management Studio, or any external application that can create a well-formed REST web service input and make a REST web service POST call.

**Identifying Issues in Data**

To identify issues, perform the following steps in SAS Data Management Studio:

1. Create some sample data where at least one item is missing the transaction amount. This can be data in a text file, in a database table, or even generated in a SAS Data Management Studio job. Here are a few sample data rows with column headings:

   **Table 5.1 Sample Data**

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>TransactionValue</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Laptop</td>
<td>1213.01</td>
</tr>
<tr>
<td>2</td>
<td>Mouse</td>
<td>13.15</td>
</tr>
<tr>
<td>3</td>
<td>Monitor</td>
<td>128.20</td>
</tr>
<tr>
<td>4</td>
<td>Carrying Case</td>
<td>5.55</td>
</tr>
<tr>
<td>5</td>
<td>Network Cable</td>
<td></td>
</tr>
</tbody>
</table>

2. Create a SAS Data Management Studio job that accesses your sample data. Once you have created a new source of input data, use a data validation node to flag the row of data that contains no transaction value (Transaction Value is null).

   In this example, the row that contains no transaction value is flagged with a value of 1. Use a Branch node to create a branched path in your job where only records that contain a 1 in the **Flag** field will be present.

3. Create the input data for the SAS Data Remediation REST web service call. Use an expression node to create the input string. Field substitution is used to pass the values from the sample data row into the web service call.

   ```
   string(1000) WS_IN
   WS_IN =
   '{
   "application":"POS System",
   "subjectArea":"Sales Transaction",
   "name":"Weekly Update",
   "description":"Transaction validation process.",
   "userDefinedFieldLabels": null,
   ```
"topics":
{
  "name": "&\Name\&",
  "key": "&\ID\&",
  "userDefinedFields": null,
  "issues": [
    {
      "name": "Missing Transaction Total",
      "importance": "low",
      "note": "Please research this transaction.",
      "url": "http://www.website.com",
      "assignee": {"name": "Data Steward"},
      "status": "open"
    }
  ]
}

Note: For more information about the SAS Data Remediation REST API (also known as the Issues API), see the SAS support site.

4 After adding this expression to create the input string in a JSON format, use an HTTP node to invoke the web service on the SAS mid-tier server. Use the following settings for this node:

Table 5.2 HTTP Node

<table>
<thead>
<tr>
<th>Address</th>
<th>http://[server]:[port]/SASDataRemediation/rest/groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
<td>post</td>
</tr>
<tr>
<td>Input: Field</td>
<td>WS_IN</td>
</tr>
<tr>
<td>Output: Field</td>
<td>WS_OUT (create using the New button and set the size to 1000)</td>
</tr>
</tbody>
</table>

5 From the Security option, enter a user name and password under Security ▶ Enter credentials. This must be a user-defined user name and password in SAS metadata using SAS Management Console and having at least one SAS Data Remediation role associated with it.

6 In the Advanced Properties for the node, set the WSCP_HTTP_CONTENT_TYPE options to application/json.

7 Select OK, and then run your job.

Viewing the Results

To view the results on SAS Data Management Console:

1 Click Data Remediation.

2 Search the table for an issue named Missing Transaction Total. When you select this issue, all of the details that you set in the SAS Data Management Studio job for this issue are reflected in the details panel. You now can
interact with this issue as needed to track it to completion by setting assignee, status, and due date information.

3 When the issue has been corrected, select the Close option in the issue toolbar.

Workflow Integration

Creating Task Templates

If your business process requires that an issue be reviewed and corrected in a specific manner, you can choose to associate an issue type with a workflow template, also known as a task template. Once you have enabled this relationship, wherever an issue is created, interactions with the issue can be governed by a task template.

Task templates can be created and uploaded to the workflow server through SAS Workflow Studio. Task templates with specially named data objects can be used to in conjunction with SAS Data Remediation functionality such that information from the data remediation environment can be passed into the workflow instance for evaluation. For example, an issue with an importance level of Very High might trigger a different route or action in the logic of the workflow so that an e-mail notification is sent about a high priority issue in the queue.

Task templates can use policies, which are actions to be taken when a workflow task is encountered. Policies can send notifications, start other workflows, make web service calls, or invoke SAS processes. Use policies to add another layer of application integration to your data review and correction processes.

After you have chosen the options for your task template, upload it to the workflow server and activate it. This template is now available for use within SAS Data Remediation.

Associating an Issue with a Task Template

To associate an issue with a task template:

1 On the SAS Data Management Console, select Data Remediation ➤ Administration.

2 On the Data Remediation-Administration tab, select and open the Missing Transaction Total issue. A Missing Transaction Total tab is displayed with three sub-tabs.

3 On the Issues ➤ Task Templates sub-tab, select a task template to associate with Missing Transaction Total.

4 Save your settings from the Actions menu.

When you open a Missing Transaction Total issue, a Put in Workflow button appears. Clicking this button turns control of the issue over to the workflow definition. New options appear for every actionable item in your workflow. You cannot set other remediation issue options on the issue as long as it is controlled by a workflow.
Continue to address the issue through SAS Data Remediation, selecting the actions that are available to you as derived from the workflow definition. When you reach a termination step in the workflow, control is returned to SAS Data Remediation, where you close the issue and remove it from the remediation queue.
Recommended Reading

- DataFlux Data Management Studio Installation and Configuration Guide
- DataFlux Data Management Studio User's Guide
- DataFlux Data Management Server Administrator's Guide
- DataFlux Data Management Server Users’s Guide
- SAS Workflow Studio User’s Guide
- SAS Intelligence Platform Middle-Tier Administration Guide
- SAS Management Console User’s Guide
- SAS MDM User’s Guide
- SAS Task Manager User’s Guide

For a complete list of SAS books, go to support.sas.com/bookstore. If you have questions about which titles you need, please contact a SAS Book Sales Representative:

SAS Books
SAS Campus Drive
Cary, NC 27513-2414
Phone: 1-800-727-3228
Fax: 1-919-677-8166
E-mail: sasbook@sas.com
Web address: support.sas.com/bookstore
<table>
<thead>
<tr>
<th><strong>D</strong></th>
<th><strong>L</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>data remediation</td>
<td>log on, SAS Data Management</td>
</tr>
<tr>
<td>managing issues</td>
<td>Console</td>
</tr>
<tr>
<td>portlet</td>
<td>5</td>
</tr>
<tr>
<td>searches</td>
<td>logs</td>
</tr>
<tr>
<td>understanding</td>
<td>25</td>
</tr>
<tr>
<td>data remediation administration</td>
<td></td>
</tr>
<tr>
<td>issue types properties</td>
<td>preferences</td>
</tr>
<tr>
<td>properties tab</td>
<td>global</td>
</tr>
<tr>
<td>roles</td>
<td>7</td>
</tr>
<tr>
<td>subject areas permissions</td>
<td>SAS Data Management Console</td>
</tr>
<tr>
<td>subject areas properties</td>
<td>10</td>
</tr>
<tr>
<td>subject areas task templates</td>
<td>SAS Data Remediation</td>
</tr>
<tr>
<td></td>
<td>8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>G</strong></th>
<th><strong>P</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>global preferences</td>
<td>preferences</td>
</tr>
<tr>
<td></td>
<td>global</td>
</tr>
<tr>
<td></td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>SAS Data Management Console</td>
</tr>
<tr>
<td></td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>SAS Data Remediation</td>
</tr>
<tr>
<td></td>
<td>8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>H</strong></th>
<th><strong>R</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>home page, SAS Data Management</td>
<td>reports, SAS Visual Analytics</td>
</tr>
<tr>
<td>Console</td>
<td>36</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>I</strong></th>
<th><strong>S</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>interface, SAS Data Remediation</td>
<td>SAS Data Management Console</td>
</tr>
<tr>
<td></td>
<td>home page</td>
</tr>
<tr>
<td></td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>log on</td>
</tr>
<tr>
<td></td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>preferences</td>
</tr>
<tr>
<td></td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>SAS Data Remediation</td>
</tr>
<tr>
<td></td>
<td>interface</td>
</tr>
<tr>
<td></td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>preferences</td>
</tr>
<tr>
<td></td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>SAS Visual Analytics</td>
</tr>
<tr>
<td></td>
<td>reports</td>
</tr>
<tr>
<td></td>
<td>36</td>
</tr>
</tbody>
</table>
Gain Greater Insight into Your SAS® Software with SAS Books.

Discover all that you need on your journey to knowledge and empowerment.

support.sas.com/bookstore for additional books and resources.